
Sage 100 2024

What's New Guide

February 2026



This is a publication of Sage Software, Inc.

© 2026 The Sage Group plc or its licensors. All rights reserved. Sage, Sage logos, and 
Sage product and service names mentioned herein are the trademarks of The Sage Group 
plc or its licensors. All other trademarks are the property of their respective owners.

Last updated: February 23, 2026



Contents

What's New in Sage 100 1

What's New in Version 2024.4 2

What's New in Version 2024.3 3
Library Master 3

What's New in Version 2024.2 4
Production Management 4

Sage Supply Chain Intelligence (SSCI) Integration – Available Fall 2025 4

What's New in Version 2024.1 5
Sage 100 Desktop Change 5

Global Change 5

Accounts Payable 5

Inventory Requirements Planning 6

Library Master 7

Production Management 7

Sales Order 8

What's New in Version 2024 9
Sage 100 Desktop Changes 9

Global Changes 9

Accounts Payable 12

Inventory Management 13

Inventory Requirements Planning 14

Library Master 14

Paperless Office 15

Production Management 17

Purchase Order 18

Return Merchandise Authorization 19

Sales Order 19

Sage 100 What's New Guide i



Index 21

Sage 100 What's New Guide ii

Contents



What's New in Sage 100

This document describes the enhancements added in Sage 100 version 2024 and 
subsequent updates. Changes to the Sage 100 Desktop are listed first, followed by global 
changes and then module-specific changes.

Depending on your purchase agreement, some features described here may not be 
available in your product. 
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What's New in Version 2024.4

What's New in Version 2024.4

Version 2024.4 contains program fixes for Sage 100. For more information, see the 
release notes.
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What's New in Version 2024.3

The following enhancement was added in update 3 for Sage 100 2024.

Library Master

Improvement to Installed Modules Listing

The registered customer name and customer number have been added to the Installed 
Modules Listing.
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What's New in Version 2024.2

What's New in Version 2024.2

The following enhancements were added in update 2 for Sage 100 2024.

Production Management
The following change was made in the Production Management module.

Option to Relieve WIP on Last Completion

On the Production Management Options Entry tab, the Relieve WIP on Last Completion 
check box has been added. Select it to post remaining WIP to the inventory account when 
the work ticket is completed.

Sage Supply Chain Intelligence (SSCI) Integration – 
Available Fall 2025
Integrate Sage 100 with Sage Supply Chain Intelligence (formerly known as Anvyl)  for 
powerful purchase order management.  SSCI bridges the gap between issuance of a 
purchase order and receipt of goods, providing a cloud-based way to collaborate with 
suppliers, consolidate shipments, create custom P/O workflows, and even create and edit 
purchase orders, and have the data flow back into Sage 100.

Use the Sage Supply Chain Intelligence Setup app to perform integration for Sage 100 
2025, 2024.2, and 2023.5.

For instructions, see Set Up Sage Supply Chain Intelligence (Anvyl) Integration in 
Sage 100 help.
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What's New in Version 2024.1

The following enhancements were added in update 1 for Sage 100 2024.

Sage 100 Desktop Change
The following change was made to the Sage 100 Desktop.

Updated Tour the Desktop Video

On the Help tab, click the Tour the Desktop Video button to view the most recent features 
added to the Sage 100 Desktop and learn how to customize your Desktop.

Global Change
The following global change was made.

Microsoft SQL Server Installation Change

Sage no longer includes a Microsoft SQL Server Runtime Edition for Sage 100 installed 
with Client/Server architecture using a Microsoft SQL Server database. For more 
information, see Microsoft SQL Server Installation Process in the Sage 100 2024 
Installation Guide on the Sage 100 Documents page.

Accounts Payable
The following change was made in the Accounts Payable module.

1099 Form Changes for Individuals

To support 1099 Form changes for individuals, the following fields have been added on 
the Vendor Maintenance Additional tab and print on the Vendor Listing:

 l (1099 Form) First Name             

 l (1099 Form) Middle Name             

 l (1099 Form) Last Name             
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Inventory Requirements Planning

These fields are available only when Individual is selected in the Vendor Type field.

Inventory Requirements Planning
The following changes were made in the Inventory Requirements Planning module.

Explode Bill without Production Management Integration

You can now explode parent and component items on a multi-level bill even if Inventory 
Requirements Planning is not integrated with the Production Management module. The 
Bill of Materials module must be set up for the current company to explode items.

Consolidate Demands

Demands are now consolidated for the same item when creating a work ticket or 
purchase order to stock. This enhancement allows you to create one work ticket or 
purchase order for multiple demands on the same item, instead of creating a separate 
work ticket or purchase order for each demand. Demands for the same item are 
consolidated automatically if the item’s procurement type is Make to Stock or Buy to 
Stock.

In addition, the following changes have been made:

 l In the Item Detail window, the default selection in the Make To field is now based on 
the item’s procurement type.    

 l In the Items to Produce/Items to Purchase window:     

 l You can now increase the production/purchase quantity beyond the 
quantity recommended.      

 l If an item has a price level set and you change the production/purchase 
quantity, the Unit Cost field is updated accordingly.      

 l When creating a work ticket or purchase order to stock, IRP will use the 
earliest demand date as the date required.    

Option to Explode Phantom Bills

The Include Phantom Bills check box has been added in Inventory Requirements 
Planning Options. You can select this check box to explode the components of the 
phantom bill onto the level of the bill where the phantom bill appears.
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Library Master
The following change was made in the Library Master module.

Sage Connect Integration

You can integrate Sage 100 with Sage Connect, an application built on Sage Network 
platform. This integration enables a one-way push of data from a Sage 100 company to 
Sage Connect.

Use the Sage Network Setup app to perform integration. This application will be available 
shortly as a separate installer. Contact your Sage partner.

For instructions, see Set Up Sage Connect Integration in Sage 100 help.

When a Sage 100 company is integrated with Sage Connect, the Enable Sync for Sage 
Connect check box is selected by default on the Company Maintenance Payment tab.

Production Management
The following change was made in the Production Management module.

View Quantity Remaining in Materials Where-Used Inquiry

A new Quantity Remaining column (displaying the quantity required minus the quantity 
issued) has been added in the Materials Where-Used Inquiry window.

In addition, if the selected item is the parent of a work ticket, the following changes have 
been made:

 l Description column displays "Parent Item Code" 

 l Step Number, Activity Code, and Work Center columns are blank 

 l Due Date column             displays the work ticket production due date
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Sales Order

Sales Order
The following change was made in the Sales Order module.

Apply General Ledger Account to Credit Memo

When creating a sales order credit memo and recalling the invoice from history, the new 
Apply to Credit Memo window appears. You can select to apply either the general ledger 
sales account from history or the sales return account to the credit memo.
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What's New in Version 2024

The following enhancements were added in Sage 100 2024. 

Sage 100 Desktop Changes
The following changes were made to the Sage 100 Desktop.

Resources Button 

On the  Help tab, the Resources button has been added to provide a one-stop shop to the 
Sage Community Hub, Knowledgebase, Product Documents page, Sage University, and 
additional services. 

The following buttons have been removed on the Help tab: Product Documents, 
Knowledgebase, Downloads and Updates, Online Community, Sage University, and 
Order Checks and Forms.

Information Center Page Updates

The Sage 100 Information Center page has updated links to the Resource Center, 
Product Documents page, and more. 

Global Changes
The following changes are carried throughout multiple modules.

Installation Change

The Sage 100 installation program now detects if a computer is running the 64-bit version 
or 32-bit version of Windows, and defaults the bit version of the Sage 100 install 
accordingly. 

For example, if you're installing Sage 100 2024 on a computer running the 64-bit version 
of Windows, the installation program defaults to install the 64-bit version of Sage 100 but 
can be changed. If you have other 32-bit versions of Sage 100 on your system, we 
recommend installing the 32-bit version of Sage 100. For information on how to convert to 
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Global Changes

the 64-bit version of Sage 100, see the Upgrade Guide on the Sage 100 Documents 
page.

Demo Data Refresh (Phase 1)

Inventory items and descriptions  in Sage 100 demo data have been updated to use 
current industry terms.

Automatic Display of Full Extended Item Description

In Role Maintenance, the Inventory Management security option, Allow Automatic 
Display of Full Extended Item Description When Not in a Grid, has been renamed  
Allow Automatic Display of Full Extended Item Description. 

In addition to suppressing the automatic display of the extended item description in Item 
Maintenance, you can now also suppress it in data entry tasks when the item description 
is in the primary grid and an item is entered on a new line in the grid or when tabbing past 
the item on an existing line. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Improvements to Delete and Change Utilities

The following changes have been made in Accounts Payable Delete and Change 
Vendors, Accounts Receivable Delete and Change Customers, and Inventory 
Management Delete and Change Items:

 l You can now access and enter information when data entry is in progress or the main 
entity task is in use. For example, you can access Delete and Change Vendors when 
invoice entry is in progress or when Vendor Maintenance is in use.

 l File checking occurs upon clicking the Proceed button. For example, the delete and 
change vendor process can be performed only if tasks associated with the Vendor 
table are not in use and all data entry in progress has been posted.

 l Tab order has changed. The Change tab is first, followed by the Delete tab.

 l The vendor name, customer name, or item description now displays for starting and 
ending codes in each utility.

 l New security options in Role Maintenance enable you to determine which users can 
perform the delete or change processes.
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Also, the following changes apply to General Ledger Change Accounts:

 l You can now access and enter information when data entry is in progress or the main 
entity task is in use.

 l File checking occurs upon clicking the Proceed button. The change process can be 
performed only if tasks associated with the Accounts table are not in use and all data 
entry in progress has been posted.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Improved Audit Tracking

 Data tracked and printed on the audit trail has been expanded for vendors, customers, 
employees, and items. This enhancement provides improved security compliance in the 
Accounts Payable, Accounts Receivable, Payroll, and Inventory Management modules, 
and includes the following changes:

Note: Improved audit tracking for the Payroll module is available only if Sage 100 
Payroll 2.24.1 is installed on Sage 100 2024.

 l Changes, deletions, and additions are now tracked for all data related to the main 
entity.  

 l A Purge button has been added to the audit report for each module, providing access 
to the new Purge Audit Report utility. You can also access the utility on the Utilities 
menu.

 l Task security is now used in Role Maintenance to determine access to the 
Purge Audit Report utility. Previously, security options determined access 
to the purge audit feature.

 l In the Payroll module, a Purge button has also been added to the Pay Rate 
Change Report that tracks employee pay rate changes.

 l A new Audit Viewer selection has been added to the More button in Vendor 
Maintenance, Customer Maintenance, Employee Maintenance, and Item 
Maintenance. This selection is available if the user has permissions to the audit 
report for the module in Role Maintenance.

 l In module options tasks in which you can specify changes to track for audit history, 
the default setting is now All when a new company is set up. Previously, the default 
was None.
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Accounts Payable

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Print Audit Reports Anytime

Audit reports in the Accounts Payable, Accounts Receivable, Payroll, and Inventory 
Management modules can now be printed when the main entity is in use.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

ALE Lookups

The search value will no longer be cleared when the operand is changed.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Accounts Payable
The following changes were made in the Accounts Payable module.

Vendor Date Established

On the Statistics tab in Vendor Maintenance and Vendor Inquiry, the Date Established 
field has been added to show the system date the vendor was created on. You can edit 
this field with the appropriate security setup.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

1099 Form fields for Vendor

On the Vendor Maintenance Additional tab, the following changes have been made for 
1099 Form fields:

 l The W-9 Form on File check box has been added, enabling you to track W-9 Forms 
for a vendor.

 l You can now retain the taxpayer ID/Social Security number for non-1099 vendors. If 
Business or Individual is selected at the Vendor Type field, select the new option 
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"None" at the Default Form field, and then enter the taxpayer ID number or Social 
Security number for the non-1099 vendor.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Inventory Management
The following changes were made in the Inventory Management module.

Delete Warehouses and Change Warehouses Utilities

Two new tasks, Delete Warehouses and Change Warehouses, have been added to the 
Inventory Management Utilities menu. Designed as separate tasks, these utilities feature 
task security and the following functionality: 

 l Use Delete Warehouses to delete existing warehouse codes from your company 
data files. Deleting warehouses is necessary when virtual warehouses for scrap, 
returns, and multi-bin are no longer needed, or when a physical warehouse location 
closes.

 l Use Change Warehouses to renumber or merge  existing warehouse codes in your 
company data files.

Both utilities feature the flexibility to access and enter information when data entry is in 
progress or the main entity task is in use. File checking occurs upon clicking the Proceed 
button.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Switch Views in Lot/Serial Inquiry

The Switch View button has been added in the Lot/Serial Inquiry window. Click this button 
to switch the view of columns displayed in the Lot/Serial Inquiry list box. The last view 
selected persists by user.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.
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Inventory Requirements Planning

Inventory Requirements Planning
The following change was made in the Inventory Requirements Planning module.

Regenerate IRP Data

Important! If you're upgrading from Sage 100 2023.2 or earlier, you must 
regenerate your IRP data file to apply the latest schema changes and fixes. 
Improvements have been made to correctly link components back to parent items, 
particularly when the same subassembly appears on a bill of material multiple 
times.

Library Master
The following changes were made in the Library Master module.

Restricted Mode for Administrator Tasks

A new option  to turn on Restricted mode has been added in the Administrative Tools 
screen, allowing you to limit the users that can log in to Sage 100 when Administrative 
tasks (such as testing modifications or adding user-defined fields) are performed. 

You determine which users can log in with the new Role Maintenance security option, 
Allow Access During Restricted Mode. Turning on Restricted mode will not force users 
currently logged in (without rights for Restricted mode) out of Sage 100. Instead when 
launching a new task, a message appears telling them to log out.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Email Notification for Task Scheduler Jobs

In Task Scheduler, the Job Status Notification field has been added. You can send email 
notifications when jobs succeed or fail.

Option to Process All Tasks

In Task Scheduler, the Process All Tasks check box has been added. This option 
provides you with the flexibility to process all tasks defined on the Tasks tab, even if one 
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or more tasks fail.

Field Order Changed in User Maintenance and User Settings

The  fields on the User Maintenance Preferences tab and in User Settings have been 
reorganized into groups of similar options.

Auto-Complete Search Index Automatically Updated

The Enable Update Search Index check box has been added on the Preferences tab in 
System Configuration. Select this check box to automatically update the auto-complete 
search index in the ../MAS90/MAS_System folder when changes are made to customer, 
employee, vendor, general ledger account, or item records. 

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Paperless Office
The following changes were made in the Paperless Office module.

Report Setting in Report Viewer and Period End Report Viewer

The Report Setting used to print a report or period-end report now displays in the viewer 
task, so you can easily identify reports without having to open individual PDFs.

Electronic Delivery Message Maintenance

A new [ReportSetting] token has been added as a merge field in Electronic Delivery 
Message Maintenance, allowing you to include the Report Setting used to print the report 
to PDF in the subject line and body of an email.

Option to Display PDF After Printing Report

The Display PDF After Printing check box has been added in the Paperless Office 
Selection window. 
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Paperless Office

View Detail in Results of Electronic Delivery

A Detail button has been added in the Results of Electronic Delivery window. Click it to 
view details about documents sent to customers and vendors, including the date and time 
the document was submitted and the status.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Improvements in Error During Electronic Delivery

You can now resize the Error During Electronic Delivery window to view all information. 
Also, the Copy Error Status to Clipboard button has been added to provide a one-click 
copy of Error Status text to your computer clipboard.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Option to Ignore All Errors in Setup

The Ignore All Errors check box has been added in the Form Maintenance window, 
allowing you to set the default for this option in Error During Electronic Delivery. Select 
this check box to suppress the Error During Electronic Delivery window from 
automatically displaying so that form printing tasks no longer have to be monitored for 
errors.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Improvement in Viewer Tasks

In viewer tasks, the log record you've selected in the list box now persists after clicking a 
button on the side bar.

Relink PDF Documents Utility

The Relink PDF Documents utility has been added to the Utilities menu available from the 
Run Program window. In the Sage 100 Desktop, select File > Run. In the Run Program 
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window, enter *utl at the Program field to open the Utilities menu.

Use this utility to update the PDF location reference in the Paperless Office log records 
for PDFs that were moved to a new server or folder using a method other than the Move 
button in viewer tasks. This provides a faster way to relink the Paperless Office log 
records than the Link Maintenance utility.

Production Management
The following changes were made in the Production Management module.

Activity Code List

An Activity Code List button has been added next to the Activity Code field in Activity 
Code Maintenance. Click this button to view a list of all activity codes.

Data Conversion for Earlier Version of Production Management

The Production Management module code has changed from JT to PM. When you 
convert Production Management data from an earlier version of Sage 100, the converted 
company data files are changed to use the PM prefix. 

Important! If you're upgrading from the standalone version of Production 
Management that was previously available, you must be on version 2021.x of the 
standalone version before upgrading to the Production Management module that 
is part of Sage 100 2024.

Include Materials From Option

The Include Materials From field has been added in Cost Roll-Up Register, enabling you 
to determine if materials from the bill, work ticket template, or both bill and template are 
included when calculating the cost of the bill.
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Purchase Order

Purchase Order
The following changes were made in the Purchase Order module.

Quick Close of Partially Received Purchase Orders

The Clear Back Order upon Accept check box has been added on the Lines tab in 
Receipt of Goods Entry, enabling you to easily close a partially received purchase order. 
Also, the Apply Purchase Orders button has been added next to the new check box, 
providing you with the flexibility to close any partially received purchase orders that have 
been applied to the primary order. 

This feature is available based on the new security option in Role Maintenance, Allow 
User to Clear Back-Ordered Quantity in Receipt of Goods Entry.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Received Status for Purchase Orders

A new order status of Received has been added. When purchase orders have been 
received but not invoiced, the order will now have a status of Received instead of Back 
Order to correctly reflect the state of the order. 

You can print orders and reports based on the Received status for the following:

 l Purchase Order Printing

 l Open Purchase Order Report

 l Open Orders by Item Report

 l Open Orders by Job Report

 l Purchase Order Recap

 l Open Orders by Work Ticket

 l Purchases Clearing in Open PO Format

 l Open Purchase Order Work Ticket Report (Production Management report)

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Return Merchandise Authorization
The following change was made in the Return Merchandise Authorization module.

View Applied Sales Orders

If multiple sales orders have been applied to an invoice, you can now view the sales order 
number and related customer purchase order number in the following:

 l In RMA Item Selection, the Sales Order No. and Customer PO columns have been 
added to the list box.

 l In the Invoice List lookup (accessed by clicking the Lookup button in the Invoice No. 
field on the RMA Entry or RMA Receipts Entry Lines tab), "Multiple" appears in the 
Sales Order No. and Customer PO columns when more than one order has been 
applied to the invoice. Previously, only the primary sales order and customer 
PO were displayed.

 l In the Invoice Lines List lookup (accessed by clicking the Lookup button in the Item 
Code field on the RMA Entry or RMA Receipts Entry Lines tab), the Sales Order No. 
and Customer PO columns have been added.

Sales Order
The following changes were made in the Sales Order module.

Option to Print Forms for Generated Back Orders

The Print Forms for Generated Back Orders field has been added on the Forms tab in 
Sales Order Options, enabling you to automatically reset the Print Order check box and 
Print Pick Sheets check box in Sales Order Entry for back orders created during the Sales 
Journal Update. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Display Ordered Quantity in Red

On the User Maintenance Preferences tab, an option has been added to display the 
ordered quantity in red text on the Lines tab in Sales Order Entry and S/O Invoice Entry 
when the quantity exceeds a specific value. In the S/O Ordered Qty in Red When field, 
you can select to display the ordered quantity in red text when it exceeds available 
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Sales Order

quantity, when it exceeds quantity on hand, or when the available quantity is lower than 
the reorder point.
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